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An Introduction to Readerware

Readerware is a book lovers dream come true. It includes:

A powerful SQL database to store and track your library. It 
can store thousands of titles.
Built in internet support and web browser. Readerware can 
search the internet and automatically catalog the books you 
own. There is no simpler way of cataloging your library. It 
eliminates or reduces the chore of manual data entry.
Bar code reader support, literally catalog a book at the swipe 
of a bar code wand.
User friendly database searches. Search on virtually any 
field. No database knowledge needed!
Support for multiple databases, create as many databases as 
you want or store everything in a single database.
Built in access to the ultimate reference sources, The 
Library of Congress and The British Library.
Fully integrated shopping cart with price comparison, 
secure online ordering, browsing and searching of all the 
major online retailers in Brazil, Canada, England, France, 
Germany, Switzerland and The United States.
Compare prices before you buy.
Online publishing, publish all or parts of your catalog on the 
internet.
Sophisticated reporting to produce hard copy listings of 
your library and shopping cart. Take them with you on your 
next tour of your local bookstores!
Easy to use, configurable operation
Full mouse and keyboard navigation.
Powerful import/export capabilities.
Support for multiple platforms, take Readerware and your 
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database to your platform of choice.
Full online help
Palm Pilot support

Whether you are someone who loves to read or someone who loves to collect, 
Readerware is the product for you.  
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Building Your Readerware Database

Readerware is the easiest way there is to catalog your library. It harnesses the 
power of the internet to search the online collections and catalog your library. 
You get to pick which sites it searches and the order in which it searches them. 
This document is divided into four sections:

Create your database(s)  - Optional, Readerware automatically creates a 
database  called "RWareDB.RWD". in the directory in which you 
installed the product. It will automatically load this database each time 
the product is started. So feel free to skip this step if you only want one 
database and are not too bothered where it is stored.
Auto Catalog - This is the recommended way to catalog your existing 
library. It allows you to prepare a list of books to catalog using their 
ISBN's. Then you can define the sites to search and the order in which 
to search them.
While You Browse - Using the Readerware Web Browser you can easily 
build your database as your surf the web. Simply search for a book at 
any one of the supported sites, then at a click of a button, import the 
data into your database.
Data Entry - For data entry and updating your catalogs, the Readerware 
detail view makes it simple. Full keyboard navigation, clipboard support 
etc.

 Create Your Database(s)

The first thing to decide is where to put your database and whether you want 
multiple databases, say one for fiction and one for non-fiction. By default 
Readerware creates a database called "RWareDB.RWD" in the directory in which 
you installed the product. If in any doubt. accept the default and skip the rest of 
this section.

To create a database in a different location:
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Select the File->New Database menu item
Navigate to the required directory
Enter a name for your database, (no file extension)
Press Create.

That is all there is to it. Readerware automatically remembers the name of the last 
database accessed when it starts, so your new database will be automatically 
loaded every time you start the product.

To define multiple databases, repeat the above steps as many times as necessary. 
As mentioned Readerware will automatically load the last accessed database when 
it starts. To change databases, simply:

Select the File->Open Database menu item
Locate the required database
Press Open

If you have decided to use multiple databases and would prefer that Readerware 
not pre load the last accessed database, use the Database Preferences  and change 
the Remember Loaded Database option. 
 

 Auto Catalog

Once you have your database created, you need data to put in it. Auto Catalog 
allows you to prepare a list of books to catalog using their ISBN's or bar codes. 
Then you pick the sites to search and the order in which to search them. Select 
Run and sit back and watch Readerware do the rest.

Enter an ISBN number in the ISBN/Bar code field and press the enter key. You 
can also enter the ISBN using a bar code reader. Ensure the ISBN field has the 
focus and simply use the bar code reader on any book, hardcover or paperback. 
Readerware will convert the bar code symbol into an ISBN for you. Regardless 
of how you enter it, the ISBN will move down to the ISBN List. Refer to 
Everything you ever wanted to know about an ISBN and more  if you need help 
determining the ISBN for a book. Repeat this as many times as necessary. If you 
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are creating a large list you should periodically save your list by clicking on the 
Save button. To load a  previously created list, click on Load. To clear the list, 
click on Clear.

The next step is to define the sites you want to search. Select the drop down 

arrow,  , on the Sites drop down list. Notice that this drop down list is a little 
different from normal lists, it allows you to select multiple entries. Select all the 
sites you want to search, click on the first site, then ctrl-click on additional sites. 
shift-click to select a range of sites. The drop down list does not automatically 
close after you select an item, to allow for multiple selection. When you have 
finished making all your selections, you can close the list by clicking elsewhere in 

the window or on the list close button,  . You can also change the order the 
sites are searched using Readerware Site Preferences .

So why should you search multiple sites? The short answer is that no one site 
will have all the books you are looking for. If you have books published in 
different countries, you should ensure that you select at least one site from each 
country. Older books will probably not be found at the major online vendor sites 
like Amazon, but will be found at sites such as The Library of Congress and The 
British Library. On the other hand the online vendors are more likely to have the 
latest titles listed, it may take a while for them to be catalogued at some of the 
non-commercial sites. Some sites, primarily the non-commercial sites such as 
The Library of Congress are not available 24 hours a day. Readerware currently 
supports sites in Brazil, Canada, England, France, Germany, Switzerland and The 
United States.

Does the order matter? It can, the data extracted from each site is different. 
Different sites record different information about each book You may find that 
one site has better categories than another, that you prefer the way they specify 
the title etc. As Readerware searches each site in order, and stops at the first 
match, you should list your preferred sites first.

Once you have defined your ISBN list and your sites you are ready to go, Click 
on Run and Readerware will start building your catalog. You will see it accessing 
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the various sites you selected in the status bar, and it will display a progress 
dialog letting you know how many books are still waiting to be processed.

You can interrupt the cataloging at any time by hitting Cancel. You can restart at 
any time by selecting Run again. Readerware will skip over any books it has 
already catalogued and pick up where it left off.

In the background Readerware also updates the ISBN list each time a book is 
processed. If you want you can move the progress window out of the way to 
see more of the auto-catalog activity. Simply  click on the title bar and drag the 
window out of the way. The progress window will close automatically once 
Readerware auto-catalog completes.

You may have noticed that as you added an ISBN to the list, a  question mark 
icon was displayed next to the ISBN. This indicates that Readerware auto-catalog 
has not yet searched the internet for the book. As it processes each ISBN, 
Readerware changes the icon to indicate the results. The icons are:

- This indicates that the ISBN has not yet been processed  

- The book has been processed, the book and cover image have 
been  added to the database.  

- The book has been processed and added to the database, no 
cover image was found  

- The book has been processed but could not be found at any of 
the sites  searched  

- The ISBN was already found in the Readerware database, this 
ISBN  was not processed

In addition to the icons, Readerware adds the title to any item it finds. This is a 
very handy way to identify the items that were not found by Readerware, it 
effectively gives you their location on your shelves.

Once the auto-catalog operation completes Readerware will display a completion 
dialog, listing counts of the books processed, the number found and catalogued, 
the number not found etc. If user logging is enabled, Readerware also creates a 
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log file called rwuser.log. If the books input and books added counts do not 
match you can examine this log file, it will identify each book skipped and the 
reason. You can view this log file in any text editor.

To see the data catalogued, select the Browse button,  , in the toolbar. Or use 
the Readerware Search Bar to define your own custom search of your local 
database. Either way you should now see a table listing your cataloged books.

If some books were not found, select additional sites and run again. Readerware 
will only look for books it hasn't already found, so you can run Auto Catalog any 
number of times.

As Readerware will not search for a book again once it is in the database, you 
must first delete it if you want to recatalog it Then run Auto Catalog again. If you 
ever want to start over, you can create a new database and then run your Auto 
Catalog List again. Maybe you decide you prefer the extracted data from another 
site and want to change the site order. You can have as many Auto Catalog List 
files as you want, you do not have to include all your books in one file. You could 
create a separate Auto Catalog List for each letter of the alphabet and use the 
authors last name. You can catalog by category, fiction vs non fiction, hardcover 
vs paperback. the choice is yours. You can build you library catalog over time.  
 

 While You Browse

Readerware allows you to catalog a book from the Readerware Browser Window 
as you search different sites.

Auto Catalog is the ideal tool for cataloging your existing library. You could also 
use it as you add new books to your collection. Or you can use the interactive 
import features. Interactive import allows you to search for books by ISBN or 
other criteria such as author and title. You can then import the search results into 
your Readerware database. But there is a lot more to interactive importing, you 
can browse all the major online vendor sites and catalogs, import new books as 
you find them, you can find the price of any book at all the major online vendors, 
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securely order books etc., all from within Readerware.

This section focuses on cataloging books using interactive import. Be sure to 
check out the Online ordering and strategies sections for other powerful features.

From the Web menu, select one of the search and import menu items. The 
Readerware Web Browser will open with the appropriate search selected. You 
can change the type of search from within the Readerware Browser.

If you selected an ISBN search, enter an ISBN in the search field. You can also 
enter the ISBN using a bar code reader. Next select the sites you want to search. 
On an ISBN search you can select multiple sites. Note that Readerware 
remembers the selections you make so that you do not need to keep making the 
same selections. However the site selections you make for Auto Catalog and 
Interactive imports are remembered separately. Once you have selected the sites, 
hit Search and Import to search for the book and if found import it into your 
database. Readerware will search each site until it finds a match. Then it will stop 
the search and import the data into your local database. The data extracted is 
displayed in the main window in the Readerware detail view. You can review the 
data and update it if necessary.

The Options->Automatic Database Update  Option allows you to control how 
data is imported into Readerware. If Checked the data is extracted from the site 
and added to the local database. If unchecked the data is extracted and displayed 
in the Readerware Data Entry Window, but the database is not updated. You can 
review the data and click Add if it is OK.

Use Search Only to just search for the book. Once found you can use Import to 
add it to your database.

If you select a Basic or Advanced search, you must select the site you want to 
search from the list. Readerware will then display the basic or advanced search 
page for that site. If the site you want is already selected, hit Go. Enter your 
selection criteria and perform the search. Once you have found the book you are 
looking for, hit Import and Readerware will import the data into your local 
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database. You must drill down the search results to the specific title you want to 
import. Readerware cannot import from a results list page for example as it does 
not know which particular entry you want to import. The options described 
above are also available for Basic and Advanced searches.

The basic and advanced search pages are provided by the site you selected. Some 
sites may not provide multiple search pages, in this case the same page is 
displayed regardless of whether you selected basic or advanced.

As you import books interactively using the Readerware Web Browser, they are 
also added to the Readerware Shopping Cart. You can use the shopping cart to 
run a price check on a book, to order books, maintain a want list etc. You can 
easily print the contents of your shopping cart and remove titles from you 
shopping cart as you add them to your collection. When the imported data is 
displayed in the Readerware Data Entry Window, you can uncheck the Shopping 
Cart box to import data into the database only if you prefer.  
 

 Data Entry

As mentioned above in the Interactive imports section, the Readerware detail 
view is displayed when you import data from an internet site and you can edit the 
data. The detail view is also used to display selections from the local database, 
allowing you to edit the data. You can also use it to add new books to the 
database manually if necessary. Select the Edit->Data Entry menu item or click 

on the data entry button, , in the toolbar.  
 

 Cover Images

Cover images are optional. By default support for cover images is on. This means 
that whenever you catalog a new book using Auto Catalog or interactive imports, 
Readerware will also extract the cover art, if available, and save it in the database.

Cover images can take up a lot of space so you may decide not to use this 
feature. Go to Readerware Database Preferences and clear the Include Image 
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Support check box to disable cover image support.

If you want to add cover images later, you can turn support on and then from the 
Auto Catalog panel, select Add Images to DB. Readerware will then go to all the 
web sites selected and try and find an image for each book in your database that 
does not already have an image.

If Readerware cannot find an image for a book at any web site, it will display a 
default cover image. You can provide your own default cover image. The default 
image is stored in the Readerware directory, in the images subdirectory. It is 
called cover.gif . Simply replace this file with the image of your choice. This 
image will then always be displayed, if no specific image is available for a book.

You can also manually add images to individual books in the database. Simply 
click on Select Image in the detail view and select a local image file. Readerware 
will then copy this local file and store it in the database. If you have a scanner, 
you can easily scan in the cover art of any book you own. You should save the 
image in either GIF  or JPEG format. Once the image is in the database, you can 
delete the original image if desired. You can delete an image from the Readerware 
database using the Delete Image button in the detail view.

You can use any size image you want. Most web sites use small thumbnail 
images which work very well. Typically these are 140-200 pixels high. The width 
is normally proportional to the height so varies from book to book. When creating 
your own images, you will probably want to scale them to approximately the 
same size as the images automatically extracted.

Not all web sites contain cover images.
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Customizing Readerware Extraction

First off, this is not for everyone. Customizing the Readerware extraction process means getting 
your hands dirty and writing some scripting code to massage the data extracted. But for those of 
you that have experience writing scripts, this is an extremely powerful feature.

So why would you want to customize the extraction? There are a number of things you can do. 
One user wanted to change the titles and strip off  leading A's. For example instead of "A Small 
Deceit" change the title to "Small Deceit" Some sites already do this, some don't. Another user 
didn't like Readerware extracting categories, he wanted to use his own. You can even substitute 
your category. Someone else wanted all new books to be set to Read. All this is possible with a 
simple script.

The way this is implemented is that Readerware will call a Python script after it extracts data from 
a web site and before it adds a book to the database. Using this script you can customize the data. 
You will find a basic copy of this script in your readerware\scrapers directory.

Here is what it looks like:

    # Scraper user exit.
    #
    # If this file exists it is called immediately
    # before the scraper process returns. You can change
    # any of the
    # global variables to customize the extraction process
    #

    import  string

    global title,author,isbn,publisher,format,first,signed,date,place
    global copies,rating,condition,category,read,pflag,eflag,value
    global comments,dateEntered,dataSource,cart,ordered
    global lccn,dewey,userNumber,copyDate,valueDate,location
    global series,pages,keywords,dimensions
    global user1,user2,user3,user4,user5,user6,user7,user8,user9,user10
    global author2,author3,author4,author5,author6
    global image,fullDateFormat,source

By itself this script does nothing, but it is the starting point for developing your own scripts. Note 
the global statements. These identify the global variable names that Readerware uses, in other 
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words the variable "title" contains the extracted title etc. This is really all you need to know about 
how the process works, you need to set or change the contents of the variables to the required 
data. So for example, if you don't want Readerware to extract categories from a web site, you 
could add the following line at the end of the script:

    category = ""

For something a little trickier, suppose you wanted to map the categories extracted from a web site 
to your own categories:

    if (string.find(category, "Mystery") != -1):
        category = "My Mystery Category"

You would need to add these kinds of statements for every category and every web site. You can 
probably see the basic idea, check for a string in the extracted category, if found replace the 
category with another. If you want to change the title as described earlier:

    if (title[0:2] == "A "):
        title = title[2:]

This may all look very strange, the script is written in the Python language. If you know Python, 
you're all set. If you know another scripting language like Perl, it shouldn't be much of a challenge.  
 

Learning Python

There are a lot of resources available on the web to help you with Python and a lot of books 
available too. Just fire up your browser and search for Python titles at your favorite book retailer. A 
good place to start your web search is at the official Python site www.python.org.

Note that you don't have to install Python, all necessary libraries are included with the Readerware 
distribution.

Python is a very powerful language and fairly easy to learn. If you're wondering about the name, 
yes it was named after Monty. Unfortunately I cannot offer support on Python itself. You will need 
to discover the power of Python for yourself.

A book I really like is "Learning Python by Mark Lutz", it has a very readable approach, covers the 
basics and advanced topics. The "Python Pocket Reference by Mark Lutz" is a handy thing to keep 
by your keyboard. A friend recommends "Python Programming on Win 32 by Mark Hammond", it 
covers Python with particular emphasis on using it with Windows.  
 

Debugging Your Script

Even the best Python programmer is going to make a mistake once in a while. Fortunately it is very 
easy to debug your scripts with Readerware. First, start Readerware, go to General Preferences  
and ensure the User logging check box is checked. You must restart Readerware when you 
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change this option.

Use Readerware as normal. When extracting data Readerware will output debugging information 
and any error messages to a log file, rwuser.log. You can view this file in any text editor.

Also with debug on, Readerware will write the HTML file it retrieved from the web site to the 
Readerware directory as trace.html. This can be useful sometimes when debugging scripts.
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Readerware Loan Tracker

The Readerware Loan Tracker provides an easy way to track books out on loan, 
you can easily loan out a book, set a due date and search for all books out on loan 
and books overdue.

To access the Readerware Book Tracker click on the Loan button from the 
Readerware detail view while displaying any book in your collection.

In The Readerware Loan Tracker Window, you can enter the following 
information:

Loan Number - If you have multiple copies of a book, you can have 
multiple loan records. Readerware will not allow more loan records 
than you have copies.

To add a new loan, select the <New Loan> entry. If this entry is not 
in the list, it means that you have already loaned out all copies.

To update an existing loan or return a book, (delete the loan), select 
the appropriate loan number. If no loan numbers are displayed in the 
list, there are no existing loans.

Loaned To - The name of the person or organization borrowing the 
book, (Required field)

Loaned Date  - The loan date, this defaults to the current date, 
(Required field)

Due Date  - The due date, this defaults to one week from the loan 
date, (Required field)

Click on the New Loan button to add the book to the Readerware Loan Tracker 
database.
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Click on Update Loan to update an existing loan entry.

When the book is returned, click on the Returned button to delete the book from 
the Readerware Loan Tracker database.

Click on Cancel to dismiss the Readerware Loan Tracker without making any 
changes.

To search for books out on loan, use the standard Readerware Search facility and 
select On Loan from the search by combo box and either Out On Loan  or 
Overdue Books from the search for drop down list.
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Database Statistics

You can display the database statistics dialog by selecting the Views->Statistics 
menu item. It is important to understand that the statistics are for the current 
search results. So if you want the statistics for the full database, make sure you 

did a full database search or click on the  Browse button,  , in the toolbar.  
This means that you can also get statistics for books by category  on loan etc.

This dialog contains the following information about your books:  
 

Total Books - This is the total number of books included.

Total Value - This is the total value of all the books. This is just a 
simple accumulation of the  estimated value field. It does not perform 
any currency conversion. If you use this field, you should ensure 
that foreign currencies imported from overseas web sites are 
converted before entering them into the database.

Unvalued Books  - The number of books that do not have an 
estimated value.

Firsts - The number of first editions.

Signed - The number of signed copies

Read - The number of books flagged as read

Unread  - The number of books  not flagged  as read. Just waiting 
for a rainy day.
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Adding to Readerware Lists

When you enter data into Readerware products, you will notice that several fields 
are lists. You select the appropriate item from the list. Fields that work this way 
include:

Format
Series
Category
Rating
Condition
Location
Sound
Color
Rating

So how do you add new entries to the list? It is actually very easy, you can add, 
update and delete items right from the list itself. Each list has a popup menu, 
simply right click on the field and select the operation you want to perform from 
the popup menu.

Mac OS X users, hold down the Control key while clicking to display the popup 
menu.
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The items we are interested in here are the last three items. In the following 
examples I use the category fields, but the same instructions apply to any of the 
other fields listed above. you can maintain a list wherever it is displayed, i.e. in 
the detail view  on the edit mode in the table view etc. 
  
 

 Adding New Category

To add a new category simply type the new value into the category field, right 
click and select Add to Database from the popup menu. Readerware will then 
add this new item to the Category list. This only adds it to the list. If you also 
want to change the displayed book to use this new category, make sure it is 
selected and update the book.  
  
 

 Changing a Category

To change  an existing category, first select it. Then make the necessary 
changes, right click and select  Replace in Database from the popup menu.
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It is important to understand that a book in the Readerware database does not 
include the full category, instead it holds the category key and uses the key to 
access the real category description when it is displayed. This means that if you 
update a category, all books in the database that use this category, will now use 
the new category.

If you want to change the category, just in the current book, don't update the 
category, add a new one instead. To simplify data entry, you can select  a current 
category, make changes to it, right click and select Add to Database from the 
popup menu.  
  
 

 Deleting a Category

To delete  a category, select it, right click and select Delete from Database from 
the popup menu.

Again all books that use that category will no longer have a category. If all you 
want to do is remove the category from the current book, don't delete the 
category, just remove the selection. Display the category  list, hold down the Ctrl 
key  and click on the current selection. This will remove all selections and the 
current book will no longer have a category. Update the book to change the 
category selection in the database.  
  
 

Conclusion

Being able to maintain the list fields right in the list itself without having to bring 
up a separate list maintenance dialog is a very powerful feature. It makes editing 
your data much easier. Once you get the hang of it, list maintenance is a breeze in 
Readerware. 
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Readerware Views

Readerware has 3 different types of views that can display the current search 
results, the table view, the tree view and the fish eye view.

You can select the current view from the view drop down list in the toolbar.

You can create additional views and maintain your views from the view display 
itself, as described below, or using the View Preferences.

 You can create additional views by first selecting one of the default views, select 

the type of view you want to create. Then click on the save button,  , in the 
toolbar, immediately to the left of the view drop down list. You will be prompted 
to enter the new view name, Readerware will then copy the current view and 
create a new view under the name specified. You can then customize the new 
view.

You can rename a view or delete unwanted views using the View Preferences. 
 

 The Table View

The Table view displays the search results is a table format. A unique feature of 
the Readerware table view, is that many of the columns are displayed as links, 
just like in a browser. Clicking on the links enables you to easily refine your 
searches. For example suppose you searched for all items in the database by 

clicking on the Browse button,  , in the toolbar. Then you click on one 
particular title, now you see only items with this title.

You can use the Back/Forward buttons in the toolbar,  , to navigate 
through your result tables, so you can easily return to the full display.

You can select an item in the table by clicking on the selection icon,  . You can 
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select multiple items by holding down the Ctrl key and clicking on additional 
rows. You can select a range of items by holding down the Shift key and clicking 
on the last item in the range.

You can display the detail view for an item by clicking on the detail icon,  , 
next to the item you want to display. Use the toolbar Back/Forward buttons to 
browse through each item displaying it in the detail view. Use the Back Up button 

in the toolbar,   to return from the detail view to the table view.

You can also edit your data right there in the table. Simply click on the edit 

icon,  , next to the item you want to edit. Notice that the icon changes to 

indicate this item is in edit mode,  . Click on any column in this row to change 
the contents. An appropriate edit field is displayed. For a title it will be an entry 
field, for the category column it is the Readerware maintainable drop down list 
etc.

You can customize the table view. To show or hide columns, right click on the 
column title to display the popup menu. You can hide the current column or 
show any previously hidden columns. The new column will be shown after the 
current column. So to show a column it is best to right click on the title of the 
column that you want to appear before the new column.

You can also move columns around, simply click on the column header and drag 
the column to its desired location.

To sort the search results on any column simply click on the column header to 
sort the search results in ascending sequence. Click again to toggle the sort 
sequence and display the search results in descending order.

The current view state is always saved when you exit Readerware or switch 
views so you never have to worry about saving your changes.

You can create as many table views as you want, each containing different 
columns and in a different order. The table view works with many other 
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Readerware features. You will probably want to create views for more than just 
displaying data on the screen. Create report views. When you print the table view 
Readerware will print the current search results, just the columns displayed, in 
the correct order. Create a summary report view with just a couple of key 
columns, create an inventory report view with valuation columns etc. Again, you 
can create an unlimited number of views.

If you regularly export data from Readerware, create an export view to define 
just how you want to export the data.  
 

 The Tree View

The Tree  View displays a familiar explorer like tree structure. The tree nodes 
consist of authors and titles.

Click on the top level Readerware node and the right pane displays a table view of 
all items in the search results. This table is fully customizable and you can edit the 
items in the table. See the table view for more information.

Click on an author node and the right pane displays a table view of all items by 
the selected author. Again this table is fully customizable and you can edit the 
items in the table. See the table view for more information.

Click on a title node and the detail view for the item will be displayed. You can 
update and delete the item from the detail; view.

The bar dividing the tree view and the rest of the window can be moved around 
to allocate space as you need. The divider position is remembered when you exit 
Readerware or switch views.

You can use the Back/Forward buttons in the toolbar,  , to navigate 
through all items. As you move between items, the detail view is displayed for 
each item and the current location is reflected in the tree. Use the toolbar  Back 

Up button,  , to return to the top of the tree.  
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 The Fish Eye View

The Fish Eye View is a revolutionary way to display a large number of search 
results. When you only have a few items in your database, it can look kind of 
silly, but try it again when you have a several hundred or several thousand titles 
and you can see the power of the fish eye view.

The view is built around the root node in the center of a circle, colored dots 
radiate out from the center. The first row of nodes are yellow and represent 
authors, the next row of dots are green and represent the titles.

Need to find a particular author? Maybe you can see the author node, simply drag 
it to the center of the view. If you cannot see a particular author, click in the 
approximate position and drag to the center. Now this area of the view is 
enlarged as it moves and you can see more detail. Select the author node or go 
straight to the titles and drag them to the center.

Right click on a title node and you can display the cover image or detail view of 
that item by selecting from the popup menu. Click anywhere in the view to 
remove the cover image

Navigate through all items in the search results using the Back/Forward buttons 

in the toolbar,  . Readerware displays each title in the detail view.

Click on the toolbar Back Up button,  , to return to the fish eye view.  
 

 Changing the Default View

Readerware is setup to automatically select the default table view when it starts 
up. You can easily change this. The view works together with the default search, 
so you change the view by changing the default search. The basic process is, 
define the search you want, select the view and save the configuration. Here is 
how you would set up the default search to display all items in the tree view:



Readerware Views 5/5

In the Search By drop down list, select Title

In the for field enter an asterisk, the Readerware wild card character

Click on Search to display all the items in your database.

Select Default Tree View from the view drop down list in the toolbar

Select Search->Save as Default Search from the Readerware menu

Next time you start Readerware it will display all items in the tree view. You can 
use this technique to customize the default search, perform any search you want 
and display any view, even user defined views.
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Searching Your Database

The Readerware Main Window contains the search bar.  This is always available 
and provides instant and easy access to the powerful search facilities built into 
Readerware.

To use the search bar simply select the type of search, Author, Title etc., enter 
the search criteria and press Search. The search criteria is case insensitive and by 
default will return books that contain the search criteria anywhere in the field. For 
example  doing a title search for murder will return:

Murder with Mirrors  
A Holiday for Murder 
The A.B.C. Murders 
Murderers Abroad

You can also use an asterisk as a wild card in your searches. For example if you 
want to search for books that begin with Murder, you could enter Murder*. 
Using the above list only the following would be returned:

Murder with Mirrors  
Murderers Abroad

The search results will then be displayed in the main window using the currently 
selected view. You can then edit the data, display the detail view etc. Exactly how 
you do this will depend on the view type you selected. Refer to the view section 
for more information. You can customize the views so you can display exactly 
the data you want, in the order you want.

You can abort an active search using the Stop button, , in the toolbar.

From the results table, use the toolbar backward/forward buttons, , to 
navigate through the search result pages.

Normally the search results are automatically refreshed when you update a book 




